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1. Inleiding 

1.1 Welkom 

Welkom bij de Scia Engineer Installatie Handleiding. Scia Engineer is een 
berekeningsprogramma onder Windows XP/2003/Vista/Windows 7 met een breed 
toepassingsbereik: van de controle van eenvoudige raamwerken tot het 
geavanceerde ontwerp van complexe projecten in staal, beton, hout,... 

Het programma behandelt de berekening van 2D/3D raamwerken, met inbegrip van 
profielcontrole en controle van verbindingen voor staalconstructies. Naast 
raamwerken is het ook mogelijk plaat en schaal structuren te dimensioneren met 
inbegrip van geavanceerde betonberekeningen. 

Deze handleiding beschrijft de procedures voor een correcte installatie van het 
programma. 

Het tweede hoofdstuk beschrijft welk hoofdstuk nodi g is voor elk type 
installatie. Het is aangeraden eerst dit hoofdstuk te lezen. 

In de hoofdstukken drie, vier en vijf worden vervolgens alle installatietypes volledig 
toegelicht. 

In hoofdstuk zes wordt afgesloten met de eventuele te volgen uninstall-procedure. 

 

1.2 Systeemvereisten 

Om Scia Engineer te kunnen installeren, is het aangeraden om over de volgende 
systeemvereisten beschikken: 

1.2.1 Hardwarevereisten 

Processorsnelheid Pentium IV - 3Ghz 
(Aanbevolen: DualCore2 3 Ghz of hoger) 

RAM 2 GB (Aanbevolen: > 3 GB) 

Grafische kaart 256 MB, ondersteuning van OpenGL 

Vrije schrijfruimte voor 
programma, projecten en tijdelijke 
bestanden 

5 GB 

Minimale resolutie 1280 x 800 
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1.2.2 Softwarevereisten 

Scia Engineer op 
Macintosh 

Om de Scia Engineer software te laten draaien op 
een OS X, moet men deze virtualiseren. Hiervoor 

raden wij Parallels Desktop 7 aan. Wanneer 
Parallels Desktop 7 gebruikt wordt, zal een Windows 

operating system geïnstalleerd worden als een 
virtuele machine, waardoor de Windows applicaties 

dan naast de Mac OS X applicaties draaien. Op 
deze manier, kan de gebruikers de 2 systemen 

tegelijk gebruiken. 

Standalone protection 

Windows 2003 server 
Windows XP 32/64 bit    
Vista 32/64 bit            
Windows 7 - 32/64 bit 

 

Het wordt aanbevolen de laatst beschikbare Service 
Pack voor deze besturingssystemen te installeren 

behalve SP3 voor Windows XP. 

Floating protection 

De FlexNET draait op: 
Windows XP 32/64 bit                                        
Windows Vista 32/64 bit 
Windows 2008 server 64 
bit Windows 7 - 32/64 bit 

 

Het wordt aanbevolen de laatst beschikbare Service 
Pack voor deze besturingssystemen te installeren 

behalve SP3 voor Windows XP.                                                            

Allplan Scia Engineer 2012 is enkel compatibel met:  

Allplan 2009.0 
Allplan 2011.0 

Allplan Precast 2010.0 
 

Men moet eerst Allplan installeren en daarna Scia 
Engineer want anders wordt Allplan niet correct 

herkend. 

Revit Scia Engineer 2012 is enkel compatibel met:                
Revit 2012        
Revit 2013 

De Revit-link is beschikbaar op                       
www.scia-online.com/revit 

Etabs Scia Engineer 2012 is compatibel met:                   
Etabs 9.2 

IFC Scia Engineer 2012 is enkel compatibel met:          
IFC versie 2x3 

SDNF Scia Engineer 2012 is enkel compatibel met             
versie 2.0 en versie 3.0 

Tekla Scia Engineer 2012 is enkel compatibel met:          
Tekla v 15.0 and hoger 
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2. Welk hoofdstuk heeft u nodig voor uw installatie? 

In deze handleiding worden 3 mogelijke installatietypes beschreven voor de installatie 
van Scia Engineer: 

 

• LOKALE INSTALLATIE, LOKALE PROTECTIE (Hoofdstuk 3 ) 

Bij dit type installatie worden zowel Scia Engineer als de protectie op de 
(client) computer geïnstalleerd. 

  

• LOKALE INSTALLATIE, NETWERK PROTECTIE (Hoofdstuk 4 ) 

Bij dit type installatie wordt Scia Engineer op elke client computer 
geïnstalleerd. De protectie anderzijds, wordt geïnstalleerd op een netwerk 
(server). 

 

• SERVER - CLIENT INSTALLATIE (Hoofdstuk 5 ) 

Bij dit type installatie worden zowel Scia Engineer als de protectie op de 
server (netwerk) geïnstalleerd. 
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3. Lokale Installatie, Lokale Protectie  

3.1 Installatie van de Sentinel Dongle Protectie 

Indien de protectie verzorgd wordt door een hardware lock, dienen volgende stappen 
ondernomen te worden: 

• installatie Sentinel Protection Installer  

• plaatsing Sentinel Dongle 

3.1.1 Installatie van de Sentinel Protection Installer 

De Sentinel Protection Installer verzorgt de communicatie tussen Scia Engineer en de 
Sentinel Dongle. 

Kies in het Installatie & Software menu van de installatie-DVD voor Installeer 
Sentinel Driver . Volg de installatie-instructies op het scherm. 

De Sentinel Protection Installer kan ook manueel geïnstalleerd worden via 
X:\Tools\Sentinel\ Sentinel Protection Installer 7. *.exe waarbij X staat voor de 
aanduiding van het DVD-station en * voor de versie. 

� Opmerking 

Indien reeds een oudere versie van de Sentinel Syst em Driver of de Sentinel 
Protection Installer aanwezig is, dan dient deze ee rst via het configuratiescherm 
verwijderd te worden alvorens u de nieuwe Sentinel Protection Installer kan 
installeren. 

 

3.1.2 Plaatsing van de Sentinel Dongle 

De Sentinel hardware locks, in de vorm van een dongle, zijn beschikbaar in twee 
versies: ofwel voor plaatsing op een USB-poort ofwel op een parallelle poort. Plaats uw 
dongle op een vrije poort van de computer. Voor een parallelle lock wordt aangeraden 
het lock te plaatsen wanneer de computer is uitgeschakeld. 

 

3.1.3 Controle van de Sentinel Dongle 

Om de correcte installatie van de Sentinel Dongle te controleren, kan gebruik gemaakt 
worden van de Sentinel SuperPro Medic. 

3.1.3.1 Installatie Sentinel SuperPro Medic 

1. Ga via Windows Verkenner naar X:\Tools\Sentinel\  waarbij X staat voor de 
aanduiding van het DVD-station. 

2. Start het bestand Sentinel Advanced Medic.exe en volg de instructies op het 
scherm. 
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3.1.3.2  Controle werking dongle 

1. Start het bestand Sam1.3.1.exe : De Sentinel Advanced Medic verschijnt op het 
scherm. Druk hier op Troubleshoot : 

 
2. In de rechter bovenhoek van de Sentinel Advanced Medic wordt de versie van de 

geïnstalleerde Sentinel Driver weergegeven. Indien hier geen versie wordt 
weergegeven, dient de Sentinel Protection Installer geïnstalleerd te worden zoals in 
de vorige paragraaf aangegeven werd. 

 

3. In het midden van het venster onder Hint , zal het programma aangeven of er een 
dongle gevonden wordt op de computer. 

 

4. Wanneer de Sentinel Advanced Medic aangeeft dat de Sentinel dongle gevonden 
werd, is de dongle correct aangesloten op de computer via een parallelle poort of 
USB poort en is de Sentinel Protection installer juist geïnstalleerd. 
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3.2 Installatie Scia Engineer 

1. Plaats de installatie-DVD van Scia Engineer in de DVD-lade van de computer. 
Het startscherm verschijnt automatisch. Kies de gewenste taal om het menu te 
doorlopen. Het Hoofdmenu  verschijnt. 

  

In het Hoofdmenu  kiest u vervolgens de optie Installatie & Software . 
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2. In het Installatie & Software  -menu kiest u vervolgens de optie Installeer Scia 
Engineer  

 
 

� Opmerking 

Indien het startscherm niet kan getoond worden door  het ontbreken van de 
benodigde ActiveX component, kan de installatie ook  manueel gestart worden via 
Windows Verkenner. Start het bestand X:\Setup\DISK1 \Setup.exe waarbij X staat voor 
de aanduiding van het DVD-station. 

 

3. In het Kies het Setup Type om te installeren -menu kiest u vervolgens de 
optie Installeer Enkel op-zichzelf-staand  

  

4. In het dialoogvenster dat verschijnt, kan de gewenste taal voor de installatie 
gekozen worden: 
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De taal welke gekozen wordt voor de installatie, is ook de standaard taal die 
gekozen wordt voor de helpbestanden van Scia Engineer. 

5. Het welkomstscherm voor de installatie verschijnt. 
Druk op [Volgende]  om verder te gaan. 

6. Bij de Klantgegevens  kan de bedrijfsnaam en de gebruikersnaam worden 
ingevoerd. De bedrijfsnaam komt automatisch op het document van Scia 
Engineer. 

 

Druk op [Volgende]  om verder te gaan. 
 

7. In het venster Doellocatie  kan het pad waar de bestanden worden 
geïnstalleerd, worden ingesteld. Standaard gebeurt dit in de map Program Files. 
Het wordt aangeraden deze standaardlocatie te behouden. 
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Druk op [Volgende]  om verder te gaan. 
 

8. In het venster Type Installatie  kan de gewenste installatievorm gekozen 
worden. 

 

Druk op [Volgende]  om verder te gaan. 
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� Opmerking 

Bij een Standaard-installatie worden NIET alle taal modules geïnstalleerd, enkel de 
Engelse taal en de taal gekozen voor installatie. I ndien u ook andere talen wenst te 
installeren, zoals bijvoorbeeld Frans of Duits, dan  dient u voor een Aangepaste 
installatie te kiezen waarbij meerdere talen kunnen  worden aangevinkt. 

 

Om in het programma een andere taal voor de werkrui mte of de uitvoer te kunnen 
kiezen dient aan twee voorwaarden voldaan te zijn: 

• De desbetreffende taal dient geïnstalleerd te zijn.  

• De benodigde taalmodule dient actief te zijn in de dongle of op de server. 

Om één van de Scia Engineer plug-ins te installeren, dient de plug-in in de 
aangepaste installatie geselecteerd te worden. 
De volgende plug-ins zijn beschikbaar: Tekla Structures plug-in, Revit Structure plug-
in, CADS RC Link Designer, BS2000, Pipeline Wizard,  Composite Beam, Composite 
Column, Arcelor Mittal-Cellular beams. 

 

9. In het venster Protectie standaard waarden  kunnen de default-instellingen 
gedaan worden voor de beveiliging. 

 

• Kies voor Enkel op-zichzelf-staand . 

• Vink de optie activeer licentie na het beëindigen van de setup aan. Deze 
optie zorgt dat het licentiebestand onmiddellijk gebruikt wordt na het 
installeren van deze protectiesoftware. Hierbij moet u wel er voor zorgen dat 
uw dongle op de computer steekt. 

 

Druk op [Volgende]  om verder te gaan. 
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� Opmerking 

Wanneer u een enkel-op-zichzelf-staande dongle gebruikt en een FlexNET netwerk 
licentie, kies dan voor de optie ‘Eerst op-zichzelf -staand, dan floating’, of ‘Eerst 
floating, dan op-zichzelf-staand’. 

 

10. In het venster Standaardinstellingen programma  worden de 
standaardinstellingen gedaan met betrekking tot het hanteren van de nationale 
normen. 

 

Kies hier uw standaard keuze voor de Nationale norm en voor uw standaard 
meetsysteem. 

Druk op [Volgende]  om verder te gaan. 

 

11. In het laatste venster zijn de door u gemaakte installatie-instellingen opgelijst. 
Zo kunt u eenvoudig controleren en na eventuele aanpassingen overgaan tot de 
effectieve installatie. Druk hiervoor op [Installeren] . 
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12. Na de installatie verschijnt de melding dat Scia Engineer met succes 
geïnstalleerd is. Druk op [Voltooien]  om de installatie te beëindigen. 

 

 

� Opmerking 

Indien UAC (User Access Control) is geactiveerd, za l het volgende scherm 
verschijnen op het einde van de installatie: 
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Kies voor ‘Install this driver software anyway’ om de installatie te voltooien. 

 

� Let op! 

Voor het gebruik van Scia Engineer volstaan standaa rd gebruikersrechten, hier zijn 
geen Administrator rechten nodig.  

Wel dient de gebruiker lees- en schrijfrechten te h ebben op de mappen van Scia 
Engineer:  

Windows XP: C:\Documents and Settings\#USER#\ESA** 

Windows Vista, Windows 7: C:\USERS\#USER#\ESA** 

Waarbij ** staat voor de versie en #USER#  voor de gebruikers login naam.  

 

3.3 Start Scia Engineer 
Dubbelklik op het Scia Engineer 2012.0  -symbool om het programma te starten. 

 

3.3.1 Scia Engineer start op 

Indien de protectie correct geüpdate werd, zal Scia Engineer opstarten en is de 
installatie beëindigd. 
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3.3.2 Scia Engineer start niet op 

Indien de protectie niet correct geüpdate werd, zal bij het dubbelklikken op het 
symbool van Scia Engineer, het volgende scherm verschijnen:

 
1. Scia Engineer kan niet opstarten zonder een correcte protectie. Druk op  

[Instellingen]  om de Protectie instellingen  te starten en de protectie te updaten. 
 

2. Het venster van de Protectie instellingen verschijnt: 

 

Kies voor de optie Enkel op-zichzelf-staand  en druk op Importeer licentie 
bestand . Het licentiebestand zal automatisch geïmporteerd worden van de Scia 
protection server en het volgende venster verschijnt:

 

Druk ok [OK] om deze melding af te sluiten. 
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� Opmerking 

• Automatisch importeren van het licentiebestand van de Scia protection server kan 
enkel indien de sleutel op de computer aanwezig is en wanneer er internetverbinding 
is. 

Het importeren van dit licentiebestand is enkel mog elijk als de gebruiker 
schrijfrechten heeft op de folder van de licentiefi le (zie ook opmerking hieronder). 

• Het is mogelijk om het adres van de folder waarin d e licentiefile wordt 
weggeschreven te veranderen. Dit kan gedaan worden door met de rechtermuis 
knop bovenaan op de balk van de Protectie instellin gen te klikken: 

 
En hier te kiezen voor [Geavanceerde instellingen.. .]  

 
Hier kan dan vervolgens het adres naar de folder wa arin de licentiefile wordt 
weggeschreven, veranderd worden. 

• Indien u een editie en dynamisch pakket van Scia En gineer heeft aangeschaft, zal u 
naast een SCIAxx.lic-bestand ook een SCIAxx.e2c-bes tand hebben. In dit geval moet 
u er voor zorgen dat beide bestanden in dezelfde fo lder staan op het moment dat u de 
licentiefile importeert. Indien u deze importeert v anaf de DVD is dit automatisch in 
orde. 

3. Van zodra het licentiebestand correct geïmporteerd is, kan de gebruiker een lijst van 
zijn commerciële modules zien door te klikken op “Uitklappen” in het venster van de 
protectie instellingen. 

4. Druk op [OK]  om de protectie instellingen te sluiten. 



Scia Engineer 

16 

5. Nu zal Scia Engineer 2012.0 automatisch opstarten. Indien het programma niet 
opstart, dubbelklik dan op het Scia Engineer 2012.0  symbool om het programma te 
starten. 

 
6. Indien de protectie correct geüpdate werd, zal Scia Engineer opstarten en is de 

installatie beëindigd. 

 

3.3.3 Controleer op update   

In Scia Engineer is het mogelijk om te controleren of een nieuwere patch beschikbaar is 
via Help -> Controleer op update . 

Het is mogelijk om deze optie te deactiveren via de registry op de client computer via: 
HKEY_CURRENT_USER\Software\SCIA\Esa\11\Admin\Settings\EnableUpdateMenu = 
0 

3.4 Update dongle 

Een update van een dongel houdt in dat het licentiebestand dient vervangen te worden. 
Deze update is nodig:  

a) wanneer er een hogere versie van Scia Engineer wordt geïnstalleerd; 

b) wanneer het aantal licenties voor bestaande modules gewijzigd is; 

wanneer nieuwe modules aangekocht werden. 

 

De dongel kan worden geupdate met de volgende stappen: 

1. Open de protectie instellingen  (onder Windows via “Start < All programs > Scia 
Engineer 2012.0 > Protectie instellingen”) 

2. druk op Importeer licentie bestand  in het venster van de Potectie instellingen 

3. De volgende melding zal verschijnen indien de licentiefile geupdate is: 
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� Opmerking 

Automatisch importeren van het licentiebestand van de Scia protection server kan 
enkel indien de sleutel op de computer aanwezig is en wanneer er internetverbinding 
is  

Het importeren van dit licentiebestand is enkel mog elijk als de gebruiker 
schrijfrechten heeft op de folder van de licentiefi le (zie ook opmerking hieronder). 

Het is mogelijk om het adres van de folder waarin d e licentiefile wordt 
weggeschreven te veranderen. Dit kan gedaan worden door met de rechtermuis 
knop bovenaan op de balk van de Protectie instellin gen te klikken: 

 
 
En hier te kiezen voor [Geavanceerde instellingen.. .]  

 
Hier kan dan vervolgens het adres naar de folder wa arin de licentiefile wordt 
weggeschreven, veranderd worden. 

 

3.5 Meerdere dongels samen gebruiken 
Het is mogelijk om alle dongels die op de computer zitten, samen te gebruiken. De LockID 
nummers van alle aangesloten dongels worden afgebeeld in het venster van de protectie 
instellingen:  
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In de lijst van de beschikbare commerciële modules wordt de som van alle modules van 
alle licentiebestanden van alle dongels weergegeven. En deze kunnen allemaal tegelijk 
gebruikt worden in Scia Engineer. 
 

� Opmerking 

De optie [Importeer licentie bestand kan uitgevoerd  worden indien er meerdere 
dongels aanwezig zijn. Het is eveneens mogelijk om verschillende dongels te 
gebruiken met verschillende tijdsgerelateerde geldi gheid. Indien een bepaalde 
module op meerdere sleutels voorkomt, zal deze gebr uikt worden van het 
licentiebestand waarvoor deze nog het langste geldi g is (hoogste geldigheid in tijd).   
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4. Lokale Installatie, Netwerk Protectie  

Dit hoofdstuk beschrijft de te volgen procedure voor het installeren van een licentie 
server. Scia Engineer wordt lokaal op de client PC’s geïnstalleerd, enkel de protectie 
bevindt zich op de server. 

De netwerkprotectie kan geïnstalleerd worden op elke computer binnen het netwerk. Dit 
hoeft dus niet de domain of file server te zijn. Elk van de geautoriseerde modules kan 
een verschillend aantal licenties hebben welke simultaan kunnen gestart worden. Bij dit 
type van protectie krijgt de gebruiker alvorens Scia Engineer opgestart wordt, de keuze 
welke modules hij wenst te gebruiken en welke modules hij beschikbaar wenst te laten 
voor andere gebruikers. 

Scia Engineer maakt gebruik van een FlexNET netwerk dongle voor de floating 
protection. Deze wijziging zorgt ervoor dat het licentie bestand gekoppeld is aan de 
dongle en niet meer aan het MAC-adres van de server. Op die manier kan de protectie 
eenvoudig verplaatst worden naar een andere computer zonder dat het licentiebestand 
dient gewijzigd te worden. 

De installatie bestaat uit volgende stappen: 

• installatie of update van de FlexNet Netwerk protectie op de server, 

• installatie van Scia Engineer op de client computer. 

Het is aangeraden om de altijd de meest recent versie van FlexNET te installeren. Deze 
kan gevonden worden op de volgende site: http://www.scia-online.com/update/scia-
engineer.php 

 

4.1 Installatie van de nieuwe FlexNET Netwerk protectie  

De installatie van de FlexNet Netwerk protectie bestaat uit volgende stappen: 

• Installatie van de FlexID Installer, 

• Installatie van de FlexNET Netwerk protectie op de server, 

• Activatie van de licentie 

• Configuratie van de FlexNET Server. 

 

4.1.1 Teruggeven van de licentiefile 

Indien er al een oudere versie van de SciaFlexNET geïnstalleerd is op de server, moet 
men eerst de licentie teruggeven (en deactiveren) alvorens aan de nieuwe installatie te 
beginnen. Ook wanneer de licentiefile geactiveerd is op een andere server, moet deze 
teruggegeven worden. 

Indien dit de eerste keer is dat SciaFlexNET geïsntalleerd wordt, mag u deze paragraaf 
over slaan. 
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1. Voer de FlexNET  Activation Utility uit. Deze kan teruggevonden worden op het 
volgende adres: 

 "C:\Program Files\SCIA\FlexNET\ActivationUtility\ActivationUtility.exe" 

 

2. Selecteer het licentie nummer en druk op [Return Licence]  

3. De licentiefile is nu gedeactiveerd. Druk op [Close]  

 

4.1.2 Installatie van de FlexID Network Dongle op de serv er 

Voor correcte werking van de FlexLM Dongle dient eerst het benodigde 
stuurprogramma geïnstalleerd te worden.  

Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Installeer FlexID Driver . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNet\FlexidInstaller.exe  waarbij X staat 
voor de aanduiding van het DVD-station. 

1. Volg de installatie-instructies op het scherm. Bij het venster Select Features  
maakt u de volgende keuze: 

- Parallelle dongle: Flexid 8  

  - USB dongle: Flexid 9  

2. Na het doorlopen van de installatie, dient de computer herstart te worden. 

3. Plaats de FlexID-dongle op een vrije poort van de computer. Voor een parallelle 
dongle wordt aangeraden deze dongle te plaatsen wanneer de computer is 
uitgeschakeld. 

 

4.1.3 Installatie FlexNET Netwerk protectie op de server  

1. Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Install FlexNet . Dit stuurprogramma kan ook 
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manueel geïnstalleerd worden via X:\Tools\FlexNetSetup\Setup.exe  waarbij X 
staat voor de aanduiding van het DVD-station. 

2. Volg de installatie-instructies op het scherm. 

3. De FlexNet Netwerk Protectie wordt standaard geïnstalleerd in de map 
C:\Program Files\SCIA\FlexNet . 

 

4.1.4 Activeren van de licentie file 

1. Plaats de FlexID dongle op de server. 

2. De Lock ID is geregistreerd in een .lid-bestand dat gevonden kan worden op de 
DVD. Dit bestand wordt gebruikt voor het activeren van de modules.  

Kies in het Installatie & Software -menu van de installatie-DVD voor Floating 
protection en vervolgens voor Run SCIA Activation Utility . Dit 
stuurprogramma kan ook manueel geïnstalleerd worden via 
X:\Tools\ActUtility\ActivationUtility.exe  waarbij X staat voor de aanduiding 
van het DVD-station. Er is een ook snelkoppeling naar dit stuurprogramma 
aanwezig op het Bureaublad van de computer onder de naam Activation 
Utility . 

3. Voer ActivationUtility.exe uit. 

 

Kies voor [Read Lock ID] 

Deze Lock ID is geregistreerd in SCIAxxxxxx.lid-bestand, waarbij xxxxxx staat 
voor de nummer van uw dongle. Dit nummer staat op de dongle zelf, zoals 
hieronder wordt getoond: 

 

Dongle Bestand: 

 

 

SCIA630505.lid 
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De gegevens in dit bestand samen met de aanwezigheid van de dongle op de 
server zullen geconverteerd worden tot een .lic-bestand Dit .lic-bestand zal 
gebruikt worden door FlexNET om Scia Engineer op te starten. 

Selecteer de correcte .lid-bestand, dat overeenkomt met uw donglenummer en 
klik op [Open] . 

4. Het nummer van uw licentiebestand zal in het FlexNET activation utility venster 
verschijnen. 

 

Selecteer dit nummer en kies [Activate licence] 

� Opmerking 

Het is niet mogelijk om de licentie te activeren in dien u gebruik maakt van Remote 
desktop of van een proxy server. 

 

5. Vervolgens zal de blauwe cirkel voor het nummer groen worden. Dit betekent 
dat het licentiebestand gebruikt wordt. 

 

Klik op [Close] 



4.1.5 Configuratie van de FlexNET server

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
(2009.0, 2008.1, Esa Prima WIn

 

1. Controleer of lmadmin.exe draait op de

2. Start internet en ga naar http://serveraddress:8080 (e.g. 

 

3. Druk op [Administration] 
gebruiken als username 

 

4. Ga naar de "Vendor daemon configuration" en druk op 

Configuratie van de FlexNET server  

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
, Esa Prima WIn, ..) werd FlexLM gebruikt. 

Controleer of lmadmin.exe draait op de server  

Start internet en ga naar http://serveraddress:8080 (e.g. http://localhost:8080

[Administration] en Sign In (de eerste keer dat u inlogt, kan u "admin" 
username en password) 

 

de "Vendor daemon configuration" en druk op [Administer]
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Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 

http://localhost:8080) 

 

n (de eerste keer dat u inlogt, kan u "admin" 

[Administer]  
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5. Eerst moet u de server stoppen, alvorens u veranderen gaat aanbrengen aan de 
instellingen. 

 
 

6. In het onderdeel "General configuration" moet het juiste path to license file  
(Scia_Software.lic of *.DAT) ingegeven worden en het juiste  path for the vendor 
daemon  (Scia.exe). 
Vendor daemon port  is de poort die gebruikt wordt voor de communicatie tussen 
scia.exe en lmadmin.exe. Deze is dus niet gebruikt tussen Scia Engineer en de 
licentie server. 
Restart retries  specifieert of de licentie server automatisch wordt opgestart als de 
licentie server herstart wordt. Zet deze op waarde 1  zodat deze automatisch mee 
opgestart wordt met de server. 
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� Opmerking 

Met de “SCIA_Software.lic” file, kunnen de gebruike rs werken met Scia Engineer 
2010.1 en nieuwer. Indien de gebruikers ook nog wil len werken met oudere versies 
van Scia Engineer of met Esa Prima Win, dan moet hi er de oude dat-file gebruikt 
worden. Hiervoor moet deze gekopieerd worden naar d e map van de 
“SCIA_Software.lic” file, standaard: "C:\Program Fi les (x86)\Common 
Files\Scia\LicenceServer\FlexnetServer\scia” 

Daarna moeten de eerste 2 regels van deze datfile a angepast worden zoals hieronder 
aangegeven: 

 

 

Verander “MYSERVER” in de naam van de server. 

Verander het FLEXID nummer NIET (dit hangt af van d e nummer van uw dongle) 

Verwijder het poortnummer op het einde van de eerst e rij 

Verander de tweede lijn in: VENDOR SCIA scia/scia 

 



Tenslotte moet u dan nog verwijzen naar deze datfil e in
“scia\ SCIA_Software.lic”)

 

7. In het onderdeel “vendor daemon log”
aan te passen, of om deze op te vragen

8. Sla vervolgens de veranderingen op door te drukken op 

9. En klik vervolgens op [Start

 

10. Indien u de daemon wilt stoppen, kan u drukken op
opnieuw wilt inlezen, kan u klikken op “Reread Licence Files”

 

 

Tenslotte moet u dan nog verwijzen naar deze datfil e in  lmadmin (in
SCIA_Software.lic”)  

“vendor daemon log” is het mogelijk om het adres van de log file 
aan te passen, of om deze op te vragen: 

 
Sla vervolgens de veranderingen op door te drukken op [Save] : 

 
Start ] 

 

ien u de daemon wilt stoppen, kan u drukken op "Stop". Wanneer u de licentie file 
opnieuw wilt inlezen, kan u klikken op “Reread Licence Files”. 
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lmadmin (in  plaats vanf: 

 

is het mogelijk om het adres van de log file 

 

Wanneer u de licentie file 
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� Opmerking 

De SCIA_Software.lic file is automatisch gegenereer d wanneer de licentiefile 
geactiveerd werd met de FlexNET activation utility.  Standaard gebruikt deze TCP port 
27000.  

Deze poort kan aangepast worden onder “Server confi guration -> License Server 
Configuration -> License Server Manger port”: 

 

 

4.1.6 Controle van de status van de licentieserver 
De status van de Scia License server kan gecontroleerd worden via “Dashboard”. Het is 
mogelijk om hier waarschuwingen te zien en ook welke licenties beschikbaar zijn op de 
server. 
 

 
 



Scia Engineer 

28 

4.1.7 Beveiligingsinstellingen op de server 
 
Voor servers met een Windows versie ouder dan Windows7 moeten de poorten die 
gebruikt worden door FlexNET (standaard 27000) open gezet worden. 

Indien een Windows7 -machine gebruikt wordt als server, moeten de poorten niet 
opengezet worden, maar hier moeten de programma's toegevoegd worden die 
toegelaten zijn voor een correcte protectie van Scia Engineer.  

Concreet betekent dit dat de volgende programma’s toegelaten moeten worden: 
lmgrd.exe, scia.exe en lmtools.exe 
 

4.1.8 Deactiveer het licentiebestand 

Het deactiveren van het licentiebestand is noodzakelijk wanneer de sleutel en de protectie 
van de ene server naar een andere verplaatst wordt. In dit geval is het nodig om eerst de 
licentie file te deactiveren op de oorspronkelijke server alvorens deze te activeren op de 
nieuwe server. Hiervoor kunnen volgende stappen gevolgd worden: 

1. Navigeer met Windows Verkenner naar    

C:\Program Files\SCIA\FlexNET\ActivationUtility 

2. Start ActivationUtility.exe . 

3. Selecteer het Licentienummer en kies voor [Return License]. 

4. Druk op [Close]. 

 

4.2 Installatie van Scia Engineer op de client computer 

1. Plaats de installatie-DVD van Scia Engineer in de DVD-lade van de computer. 
Het startscherm verschijnt automatisch. Kies de gewenste taal om het menu te 
doorlopen. Het Hoofdmenu  verschijnt: 
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In het Hoofdmenu  kiest u vervolgens de optie Installatie & Software . 

2. In het Installatie & Software menu kiest u vervolgens de optie Installeer  
Scia Engineer . 

 

 

� Opmerking 

Indien het startscherm niet kan getoond worden door  het ontbreken van de 
benodigde ActiveX component, kan de installatie ook  manueel gestart worden via 
Windows Verkenner. Start het bestand X:\Setup\DISK1 \Setup.exe waarbij X staat voor 
de aanduiding van het DVD-station. 

 

3. In het Kies het Setup Type om te installeren –menu, kiest u vervolgens de 
optie Installeer Enkel op-zichzelf-staand  
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4. In het daarop volgend dialoogvenster kan de gewenste taal voor de installatie 
gekozen worden: 

 

De taal welke gekozen wordt voor de installatie is ook de standaard taal die 
gekozen wordt voor de help bestanden van Scia Engineer. 

5. Het welkomstscherm voor de installatie verschijnt. 
Druk op [Volgende]  om verder te gaan. 

6. Bij de Klantgegevens  kan de bedrijfsnaam en de gebruikersnaam worden 
ingevoerd. De bedrijfsnaam komt automatisch op het document van Scia 
Engineer. 

 

Druk op [Volgende]  om verder te gaan. 
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7. In het venster Doellocatie  kan het pad, waar de bestanden worden 
geïnstalleerd, worden ingesteld. Standaard gebeurt dit in de map Program Files. 
Het wordt aangeraden deze standaardlocatie te behouden. 

 

Druk op [Volgende]  om verder te gaan. 
 

8. In het venster Type installatie  kan de gewenste installatievorm gekozen 
worden. 

 

Druk op [Volgende]  om verder te gaan. 
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� Opmerking 

Om in het programma een andere taal voor de werkrui mte of de uitvoer te kunnen 
kiezen dient aan twee voorwaarden voldaan te zijn: 

• De desbetreffende taal dient geïnstalleerd te zijn.  

• De benodigde taalmodule dient actief te zijn in de dongle of op de server. 

Om één van de Scia Engineer plug-ins te installeren, dient de plug-in in de 
Aangepaste installatie geselecteerd te worden. 
De volgende plug-ins zijn beschikbaar: Tekla Structures plug-in, Revit Structure plug-
in, CADS RC Link Designer, BS2000, Pipeline Wizard,  Composite Beam, Composite 
Column, Arcelor Mittal-Cellular beams. 

 

9. In het venster Protectie standaard waarden  kunnen de default-instellingen 
gedaan worden voor de beveiliging. 

 

• Kies voor Enkel floating . 

• Vul het correcte adres in naar de Licentie server : 

o Bijvoorbeeld ‘27000@Server’ 

o Het nummer 27000 verwijst naar de gebruikte TCP-port. Standaard is 
deze poort 27000, maar deze kan aangepast worden (zie ook eerder 
in hoofdstuk 4.2.4).  

o De naam Server  moet vervangen worden door de naam van de 
Licentieserver. 

Druk op [Volgende]  om verder te gaan. 
 

� Opmerking 

Wanneer u een enkel-op-zichzelf-staande dongle gebr uikt en een FlexNET netwerk 
licentie, kies dan voor de optie ‘Eerst op-zichzelf -staand, dan floating’, of ‘Eerst 
floating, dan op-zichzelf-staand’. 
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10. In het venster Standaardinstellingen programma  worden de 
standaardinstellingen gedaan met betrekking tot het hanteren van de nationale 
normen. 

 

Kies hier uw standaard keuze voor de Nationale norm en voor uw standaard 
meetsysteem. 

Druk op [Volgende]  om verder te gaan. 

11. In het laatste venster zijn de door u gemaakte installatie-instellingen opgelijst. 
Zo kunt u eenvoudig controleren en na eventuele aanpassingen overgaan tot de 
effectieve installatie. Druk hiervoor op [Installeren] . 
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12. Na installatie verschijnt de melding dat Scia Engineer met succes geïnstalleerd 
is. Druk op [Voltooien]  om de installatie te beëindigen. 

 

 

� Opmerking 

Indien UAC (User Access Control) is geactiveerd, za l het volgende scherm 
verschijnen aan het einde van de installatie: 

 
 

Kies voor ‘Install this driver software anyway’ om de installatie te voltooien. 

 

 



Scia Engineer 

35 

� Let op! 

Voor het gebruik van Scia Engineer volstaan standaa rd gebruikersrechten, hier zijn 
geen Administrator rechten nodig.  

Wel dient de gebruiker lees- en schrijfrechten te h ebben op de mappen van Scia 
Engineer:  

Windows XP: C:\Documents and Settings\#USER#\ESA** 

Windows Vista, Windows 7: C:\USERS\#USER#\ESA** 

Waarbij ** staat voor de versie en #USER#  voor de gebruikers login naam.  

 

4.3 Start Scia Engineer 

Dubbelklik op het Scia Engineer 2012.0  symbool om het programma te starten. 

 

 

4.3.1 Scia Engineer start op 

Indien de protectie correct geüpdate werd, zal Scia Engineer opstarten en is de 
installatie beëindigd. 

 

4.3.2 Scia Engineer start niet op 

Indien de protectie niet correct geüpdate werd, zal bij het dubbelklikken op het 
symbool van Scia Engineer, het volgende scherm verschijnen: 
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1. Scia Engineer kan niet opstarten zonder een correcte protectie. Druk op 
[Instellingen]  om de Protectie instellingen  te starten en de protectie te updaten. 

2. Het venster van de Protectie instellingen verschijnt: 

• Activeer de optie Enkel floating  en vul het juiste pad in naar de Licence 
server: Kies voor Enkel floating . 

• Vul het correcte adres in naar de Licentie server: 

o Bijvoorbeeld ‘27000@Server’ 

o Het nummer 27000 verwijst naar de gebruikte TCP-poort. Standaard 
is dit poort 27000, maar dat kan aangepast worden (zie ook hoofdstuk 
4.2.4 [3]). 

o De naam Server  moet vervangen worden door de naam van de 
licentieserver. 

 

Druk op [Toepassen / Herlezen]  

 

3. De beschikbare commerciële modules zullen in het venster verschijnen: 
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Druk op [OK]  om de protectie instellingen te sluiten. 
 

4. Dubbelklik op het Scia Engineer 2012.0  symbool om het programma te starten. 

 
5. Indien de protectie geüpdate is, zal Scia Engineer opstarten en is de installatie 

beëindigd. 

 

4.3.3 Controleer op update   

In Scia Engineer is het mogelijk om te controleren of een nieuwere patch beschikbaar is 
via Help -> Controleer op update . 

Het is mogelijk om deze optie te deactiveren via de registry op de client computer via: 
HKEY_CURRENT_USER\Software\SCIA\Esa\10.1\Admin\Settings\EnableUpdateMenu 
= 0 
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5. Server installatie 

Dit hoofdstuk beschrijft de te volgen procedure voor het installeren van Scia Engineer 
en de protectie op een licentie server.  

De installatie bestaat uit volgende stappen: 

• installatie of update van de FlexNet Netwerk protectie op de server. 

• installatie van Scia Engineer op de server. 

• installatie van Scia Engineer type client op de gebruikers PC. 

 

Het is aangeraden om de altijd meest recente versie van FlexNET te installeren. Deze 
kan gevonden worden op de volgende site:  

http://www.scia-online.com/update/scia-engineer.php 

� Opgelet 

Wanneer de FlexNET netwerk protectie op een nieuwe server wordt geïnstalleerd, is 
het noodzakelijk om eerst de modules ‘terug te geve n’ van de oude server naar de 
Scia Activation Server alvorens deze te activeren op de nieuwe server (zi e ook 
hoofdstuk 5.2.6 voor het deactiveren van het licent iebestand). 

 

 

5.1 Installatie van de nieuwe FlexNET Netwerk protectie  

De installatie van de FlexNet Netwerk protectie bestaat uit volgende stappen: 

• Installatie van de FlexID Installer, 

• Installatie van de FlexNET Netwerk protectie op de server, 

• Activatie van de licentie 

• Configuratie van de FlexNET Server. 

 

5.1.1 Teruggeven van de licentiefile 

Indien er al een oudere versie van de SciaFlexNET geïnstalleerd is op de server, moet 
men eerst de licentie teruggeven (en deactiveren) alvorens aan de nieuwe installatie te 
beginnen. Ook wanneer de licentiefile geactiveerd is op een andere server, moet deze 
teruggegeven worden. 

Indien dit de eerste keer is dat SciaFlexNET geïsntalleerd wordt, mag u deze paragraaf 
over slaan. 

4. Voer de FlexNET  Activation Utility uit. Deze kan teruggevonden worden op het 
volgende adres: 
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 "C:\Program Files\SCIA\FlexNET\ActivationUtility\ActivationUtility.exe" 

 

5. Selecteer het licentie nummer en druk op [Return Licence]  

6. De licentiefile is nu gedeactiveerd. Druk op [Close]  

 

5.1.2 Installatie van de FlexID Network Dongle op de serv er 

Voor correcte werking van de FlexLM Dongle dient eerst het benodigde 
stuurprogramma geïnstalleerd te worden.  

Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Installeer FlexID Driver . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNet\FlexidInstaller.exe  waarbij X staat 
voor de aanduiding van het DVD-station. 

4. Volg de installatie-instructies op het scherm. Bij het venster Select Features  
maakt u de volgende keuze: 

- Parallelle dongle: Flexid 8  

  - USB dongle: Flexid 9  

5. Na het doorlopen van de installatie, dient de computer herstart te worden. 

6. Plaats de FlexID-dongle op een vrije poort van de computer. Voor een parallelle 
dongle wordt aangeraden deze dongle te plaatsen wanneer de computer is 
uitgeschakeld. 

 

5.1.3 Installatie FlexNET Netwerk protectie op de server  

4. Kies in het Installatie & Software menu van de installatie-DVD voor Floating 
protection en vervolgens voor Install FlexNet . Dit stuurprogramma kan ook 
manueel geïnstalleerd worden via X:\Tools\FlexNetSetup\Setup.exe  waarbij X 
staat voor de aanduiding van het DVD-station. 

5. Volg de installatie-instructies op het scherm. 
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6. De FlexNet Netwerk Protectie wordt standaard geïnstalleerd in de map 
C:\Program Files\SCIA\FlexNet . 

 

5.1.4 Activeren van de licentie file 

6. Plaats de FlexID dongle op de server. 

7. De Lock ID is geregistreerd in een .lid-bestand dat gevonden kan worden op de 
DVD. Dit bestand wordt gebruikt voor het activeren van de modules.  

Kies in het Installatie & Software -menu van de installatie-DVD voor Floating 
protection en vervolgens voor Run SCIA Activation Utility . Dit 
stuurprogramma kan ook manueel geïnstalleerd worden via 
X:\Tools\ActUtility\ActivationUtility.exe  waarbij X staat voor de aanduiding 
van het DVD-station. Er is een ook snelkoppeling naar dit stuurprogramma 
aanwezig op het Bureaublad van de computer onder de naam Activation 
Utility . 

8. Voer ActivationUtility.exe uit. 

 

Kies voor [Read Lock ID] 

Deze Lock ID is geregistreerd in SCIAxxxxxx.lid-bestand, waarbij xxxxxx staat 
voor de nummer van uw dongle. Dit nummer staat op de dongle zelf, zoals 
hieronder wordt getoond: 

 

Dongle Bestand: 

 

 

SCIA630505.lid 

 

De gegevens in dit bestand samen met de aanwezigheid van de dongle op de 
server zullen geconverteerd worden tot een .lic-bestand Dit .lic-bestand zal 
gebruikt worden door FlexNET om Scia Engineer op te starten. 
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Selecteer de correcte .lid-bestand, dat overeenkomt met uw donglenummer en 
klik op [Open] . 

9. Het nummer van uw licentiebestand zal in het FlexNET activation utility venster 
verschijnen. 

 

Selecteer dit nummer en kies [Activate licence] 

� Opmerking 

Het is niet mogelijk om de licentie te activeren in dien u gebruik maakt van Remote 
desktop of van een proxy server. 

 

10. Vervolgens zal de blauwe cirkel voor het nummer groen worden. Dit betekent 
dat het licentiebestand gebruikt wordt. 

 

Klik op [Close] 

 



5.1.5 Configuratie van de FlexNET server

Vanaf versie 2010.0 gebruikt de netwerkinstallatie 
(2009.0, 2008.1, Esa Prima WIn, ..) werd FlexLM gebruikt.

 

11. Controleer of lmadmin.exe draait op de server

12. Start internet en ga naar http://serveraddress:8080 (e.g. 

 

13. Druk op [Administration] 
gebruiken als username 

 

14. Ga naar de "Vendor daemon configuration" en druk op 

Configuratie van de FlexNET server  

Vanaf versie 2010.0 gebruikt de netwerkinstallatie FlexNET. In de vorige versies 
(2009.0, 2008.1, Esa Prima WIn, ..) werd FlexLM gebruikt. 

Controleer of lmadmin.exe draait op de server  

Start internet en ga naar http://serveraddress:8080 (e.g. http://localhost:8080

[Administration] en Sign In (de eerste keer dat u inlogt, kan u "admin" 
username en password) 

 

Ga naar de "Vendor daemon configuration" en druk op [Administer]
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FlexNET. In de vorige versies 

http://localhost:8080) 

 

n (de eerste keer dat u inlogt, kan u "admin" 

[Administer]  



Scia Engineer 

43 

 
 

15. Eerst moet u de server stoppen, alvorens u veranderen gaat aanbrengen aan de 
instellingen. 

 
 

16. In het onderdeel "General configuration" moet het juiste path to license file  
(Scia_Software.lic of *.DAT) ingegeven worden en het juiste  path for the vendor 
daemon  (Scia.exe). 
Vendor daemon port  is de poort die gebruikt wordt voor de communicatie tussen 
scia.exe en lmadmin.exe. Deze is dus niet gebruikt tussen Scia Engineer en de 
licentie server. 
Restart retries  specifieert of de licentie server automatisch wordt opgestart als de 
licentie server herstart wordt. Zet deze op waarde 1  zodat deze automatisch mee 
opgestart wordt met de server. 
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� Opmerking 

Met de “SCIA_Software.lic” file, kunnen de gebruike rs werken met Scia Engineer 
2010.1 en nieuwer. Indien de gebruikers ook nog wil len werken met oudere versies 
van Scia Engineer of met Esa Prima Win, dan moet hi er de oude dat-file gebruikt 
worden. Hiervoor moet deze gekopieerd worden naar d e map van de 
“SCIA_Software.lic” file, standaard: "C:\Program Fi les (x86)\Common 
Files\Scia\LicenceServer\FlexnetServer\scia” 

Daarna moeten de eerste 2 regels van deze datfile a angepast worden zoals hieronder 
aangegeven: 

 

 

Verander “MYSERVER” in de naam van de server. 

Verander het FLEXID nummer NIET (dit hangt af van d e nummer van uw dongle) 

Verwijder het poortnummer op het einde van de eerst e rij 

Verander de tweede lijn in: VENDOR SCIA scia/scia 

 



Tenslotte moet u dan nog verwijzen naar deze datfil e in lmadmin (in
“scia\ SCIA_Software.lic”)

 

17. In het onderdeel “vendor daemon log” is het mogelijk om het adres van de log file 
aan te passen, of om deze op te vragen:

18. Sla vervolgens de veranderingen op door te drukken op 

19. En klik vervolgens op [Start]

 

20. Indien u de daemon wilt stoppen, kan u drukken op "Stop".
opnieuw wilt inlezen, kan u klikken op “Reread 

 

 

Tenslotte moet u dan nog verwijzen naar deze datfil e in lmadmin (in
SCIA_Software.lic”)  

In het onderdeel “vendor daemon log” is het mogelijk om het adres van de log file 
of om deze op te vragen: 

 
Sla vervolgens de veranderingen op door te drukken op [Save] : 

 
[Start]  

 

Indien u de daemon wilt stoppen, kan u drukken op "Stop". Wanneer u de licentie file 
opnieuw wilt inlezen, kan u klikken op “Reread Licence Files”. 
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Tenslotte moet u dan nog verwijzen naar deze datfil e in lmadmin (in  plaats vanf: 

 

In het onderdeel “vendor daemon log” is het mogelijk om het adres van de log file 

 

Wanneer u de licentie file 



Scia Engineer 

46 

� Opmerking 

De SCIA_Software.lic file is automatisch gegenereer d wanneer de licentiefile 
geactiveerd werd met de FlexNET activation utility.  Standaard gebruikt deze TCP port 
27000.  

Deze poort kan aangepast worden onder “Server confi guration -> License Server 
Configuration -> License Server Manger port”: 

 

 

5.1.6 Controle van de status van de licentieserver 
De status van de Scia License server kan gecontroleerd worden via “Dashboard”. Het is 
mogelijk om hier waarschuwingen te zien en ook welke licenties beschikbaar zijn op de 
server. 
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5.1.7 Beveiligingsinstellingen op de server 
 
Voor servers met een Windows versie ouder dan Windows7 moeten de poorten die 
gebruikt worden door FlexNET (standaard 27000) open gezet worden. 

Indien een Windows7 -machine gebruikt wordt als server, moeten de poorten niet 
opengezet worden, maar hier moeten de programma's toegevoegd worden die 
toegelaten zijn voor een correcte protectie van Scia Engineer.  

Concreet betekent dit dat de volgende programma’s toegelaten moeten worden: 
lmgrd.exe, scia.exe en lmtools.exe 
 

5.1.8 Deactiveer het licentiebestand 

Het deactiveren van het licentiebestand is noodzakelijk wanneer de sleutel en de protectie 
van de ene server naar een andere verplaatst wordt. In dit geval is het nodig om eerst de 
licentie file te deactiveren op de oorspronkelijke server alvorens deze te activeren op de 
nieuwe server. Hiervoor kunnen volgende stappen gevolgd worden: 

5. Navigeer met Windows Verkenner naar    

C:\Program Files\SCIA\FlexNET\ActivationUtility 

6. Start ActivationUtility.exe . 

7. Selecteer het Licentienummer en kies voor [Return License]. 

8. Druk op [Close]. 

 

5.2 Nieuwe netwerkinstallatie 

Dit hoofdstuk beschrijft de te volgen procedure voor het installeren van Scia Engineer 
op het netwerk. Bij deze installatie wordt Scia Engineer volledig op de server 
geïnstalleerd en kan het programma van op elk workstation in het netwerk gestart 
worden 

1. Verifieer de operating systems van de client PC’s. 

2. Maak op de server een map met alle bestanden voor de installatie van Scia 
Engineer er in. Kopieer de Disk1-map eveneens in deze map en share deze 
map + alle subfolders op het netwerk, bijvoorbeeld onder de naam ‘scia’. 

3. Installeer Scia Engineer op de server vanuit \\server\Scia met het commando: 
SETUP.EXE /v"INSTALLATION=server"   
Er wordt gevraagd naar de doellocatie: geef bijvoorbeeld Z:\Program 
Files\Scia\Engineer 2009.0 
 
Opgelet, tijdens deze stap krijgt U 4 waarschuwingsberichten van het Operating 
System. 
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4. Verbind de Z-schijf van het workstation in verbinding met de shared map op de 
server aangemaakt in stap 2 (deze moet dezelfde zijn als de doellocatie van de 
vorige stap). 

5. Installeer Scia Engineer op de client vanuit Z:\Disk1 met het commando: 
 SETUP.EXE /v"INSTALLATION=client" 
Er wordt gevraagd naar de netwerk installatiemap (vanuit stap 3). 

Opgelet, voor deze stap is het noodzakelijk dat men over ten minste 
Administrator rechten beschikt! 
Opgelet, het is niet mogelijk  om een client installatie te doen op dezelfde 
computer als van waaruit de server installatie werd gedaan. 
Opgelet, de Scia Engineer Plug-ins worden niet  geïnstalleerd. 

6. Nu kan elke gebruiker (zonder speciale rechten) Scia Engineer gebruiken van 
op dit workstation. De mapped drive dient wel dezelfde te zijn als diegene die 
gebruikt werd bij stap 4 en dezelfde als de doellocatie van stap 2. 

 

5.3 Silent install 

Een silent install  op de client PC’s kan als volgt uitgevoerd worden: 

1. Op de eerste client PC, run Setup.exe /L1033 /v”INSTALLATION=client” /r  

2. Hierbij wordt een bestand Setup.iss aangemaakt in de C:\WINDOWS map van de 
client PC. Dit bestand bevat alle informatie voor de silent install. Kopieer dit 
bestand Setup.iss naar Z:\Disk1. 

Op alle volgende client PC’s, doe een silent install met het volgende commando: 
Setup.exe /L1033 /v”INSTALLATION=client” /s . 

 

5.4 Lokale bestanden 

Het wordt aangeraden de TEMP-map, waar de tijdelijke bestanden worden opgeslagen, 
niet op de server te plaatsen, maar lokaal op elk werkstation. Dit kan binnen Scia 
Engineer worden ingesteld via Instellingen -> Opties -> Bestanden . 

Eveneens de projectbestanden, templates, gebruikersblokken, ... worden bij voorkeur 
lokaal geplaatst. 
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6. Verwijderen van Scia Engineer 

6.1 Verwijder Scia Engineer met Add/Remove Programs in Windows 

Scia Engineer kan verwijderd (‘gedeïnstalleerd’) worden zoals ieder ander 
softwarepakket onder Windows: 

1. Ga naar Add or Remove Programs  via Start > Settings > Control Panel > 
Add or Remove Programs . 

2. Een lijst met geïnstalleerde software verschijnt. Selecteer Scia Engineer en druk 
op [Change/Remove] . 

3. In het dialoogvenster dat verschijnt, kiest u de optie Verwijderen . 

 

4. Druk op [Volgende]  om het verwijderingsproces te doorlopen. 

Na dit verwijderingsproces blijven nog instellingen van het programma over in het 
Register van Windows (‘Registry’). Deze sporen kunnen handmatig verwijderd 
worden. Het verwijderen van deze sporen kan noodzakelijk zijn wanneer problemen 
ondervonden worden bij een nieuwe installatie. 

1. Open de Uitvoeren  dialoogbox via Start > Run . 

2. Typ regedit  en druk op [OK] . 
 
Opgelet, voor deze stap is het noodzakelijk dat de gebruiker over ten minste 
Administrator-rechten beschikt. 
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3. De Registry Editor  verschijnt: 
 

 

4. Ga naar volgende key’s en verwijder ze met de Delete  toets. 
 
HKEY_CURRENT_USER\Software\SCIA\ESA\* 
HKEY_LOCAL_MACHINE\Software\SCIA\ESA\* 
Waarbij * staat voor de versie. 

5. Sluit de Registry Editor  via File > Exit . 

Na het verwijderingsproces blijft volgende map nog op de harde schijf. Deze kan manueel 
verwijderd worden: 

32 bits computer:   C:\Program Files\SCIA\ESA** 

64 bits computer:  C:\Program Files (x86)\SCIA\Engineer** 

 

Ook volgende folders blijven nog staan en kunnen manueel gewist worden: 

Windows XP: C:\Documents and Settings\#USER#\ESA** 

C:\Documents and Settings\#USER#\My Documents\ESA** 
 

Windows Vista en Windows 7 :  C:\Users\#User#\Esa** 

    C:\Users\#User#\Documents\Esa** 
 

Waarbij ** telkens staat voor het versienummer. 

� Attention 

Deze mappen kunnen via Windows Verkenner verwijderd  worden. Hierbij dient wel 
opgemerkt te worden dat er zich in de eerste map pr ojecten kunnen bevinden en de 
gebruiker er zich dus dient van te vergewissen dat deze verwijderd mogen worden. 
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6.2 Verwijder Scia Engineer zonder Add/Remove Programs in Windows 

Het kan gebeuren dat Scia Engineer niet gedeïnstalleerd kan worden via “Add/Remove 
programs” van Windows. Wanneer dit dan geprobeerd wordt, geeft Windows een 
foutmelding of soms is zelfq Scia Engineer niet toegevoegd aan “Add/Remove 
Programs”. Het is dan niet mogelijk om het programma te deïnstalleren zoals in de 
vorige paragraaf beschreven.  

Dit probleem kan zich voordoen bij ieder programma gebaseerd op Windows. 

Scia Engineer kan dan gemakkelijk gedeïnstalleerd worden met de volgende procedure: 

Ga naar ‘Start’ -> ‘Run’  

Typ vervolgens het volgende commando in het dialoogvenster dat dan verschijnt:  

msiexec /x {61DD9052-B7CC-45ED-A610-824D2C25B0C0}  

Dit commando zal dezelfde procedures uitvoeren als via Add/Remove Programs en 
Scia Engineer zal gedeïnstalleerd worden. 

 


